
Introduction to Simmetry 3d 
 
This tutorial introduces you to the Simmetry 3d user interface and gives you a 
basic understanding of the how to operate the software. 
 

Concepts  
 
In this tutorial you will learn:  
 

·  what the different areas of the user interface represent 
·  how to use the interactive help system 
·  about project based working 
·  what the Project Tree shows 
·  viewing in three dimensions and Simmetry 3d Viewport system 
·  what Simmetry 3d Tools are and how to use them 

 

Prerequisites 
 

·  None 



Areas of the user interface  
 
When you run Simmetry3d for the first time you will see a window like this. 
 

 
 
This is the “Opening screen” – it lets you choose how to start a new project or 
open an existing one. If you cancel this screen you will be left with the default 
project – which looks like this: 
 



 
 

Three Dimensional View 
 
This is the main view in Simmetry 3d and shows the three dimensional scene 
and will look something like this at the moment. 
 

 
 

Menus and Tool Bars 
 



We can see at the top of the window a standard Windows menu system. 
 

 
 
Clicking on an option reveals a menu. 
 

 
 
Selecting an item from the menu will make Simmetry 3d perform the 
functionality associated with that item.   
 
There is a special tool bar which looks like this: 
 

 
 
This is the “Tool Mode” toolbar and this lets you choose mode you wish to be 
working in. Pressing each of the buttons will enable the “tools” which are 
appropriate to that mode. Try pressing some of these buttons and notice the 
effect. 

EXERCISE 
 

·  Open the View menu  
·  Click the left mouse button on the “Shaded Wireframe Terrain” menu 

option. You will see the 3d view change to grey with blue lines on it. 
 



 
 
In addition to that we also have a series of Toolbars.  
 

 
 
These are a collection of toolbar buttons that when pressed also perform the 
functionality associated with them.   
 
These buttons allow quick access to the functionality for the user, rather than 
having to use the menu system. 
 
Each button will have an icon or some text associated with it that uniquely 
identifies it from all the other buttons.  As you become more familiar with the 
icons you will find it easier to use the toolbars rather than the menu system. 
 

 
 
You may notice that some of the tool bar buttons are highlighted differently. 
This shows you that the functionality associated with that icon is currently 
active.  
 
 
If you move your mouse cursor over a tool bar button and leave it stationary 
for a couple of seconds, Simmetry 3d will show you a little yellow “hint” 
window that gives the name of the button.  This helps identify the button if you 
do not recognise the icon. 
 
Also, look down at the very bottom of the window and you will see the “status 
bar”.  This panel has various pieces of information on it, but the far left part 
shows extended hint information about what the function the tool bar button 
performs. 
 



 
 
 
In brackets are the keys on the keyboard to press that allows the user to 
activate the functionality associated with the button.  Sometimes there is no 
keyboard shortcut and the brackets do not appear. 
 

EXERCISE 
 

·  Locate the Camera|Free Look  toolbar button. 
·  Move the mouse over the button and leave the mouse stationary until 

the yellow hint window appears 
·  Look at the bottom of window to the status bar and read the extended 

“hint” 
·  Click the left mouse button on the “Free Look” toolbar button. This will 

start the Free-look camera tool which allows you to move the camera 
around the 3d design. 

 
·   Try looking left and right by pointing the mouse cursor over the 3d 

view and clicking and holding the left mouse button down and then 
moving the mouse left and right. 

Help 
 
At any time you may press the “F1” key and get access the interactive help 
file that comes with Simmetry3d.  This gives extra information about 
functionality in Simmetry3d, which you can also search through. 
 
Pressing the F1 key opens a new help window.  This can be closed 
without affecting Simmetry 3d in any way. 
 
 

EXERCISE 
 

·  Press the “F1” to open the interactive help 
·  Click on Contents Tab 
·  Open the “Terrain Editor” Section 
·  Click on the User Interface section – This contains extra information 

about the user interface. 
·  Close the interactive help by pressing on the “X” button at the top of the 

help window 



The rest of the screen is made up of several different areas. 
 

·  Panels 
·  Three Dimensional View 
·  Tool Options Bar 

 

Panels 
 
There are several panels visible to the user.  These show different information 
and each will be introduced as the tutorials progress.  Below are two 
examples. 
 

  
 

Tool Options Bar 
 

  
 
 
The use of this bar will be explained in more detail later in the tutorial. 

Tool Options Bar 



 

Advanced Options 
 
If you wish to further explore the interface, here are some suggestions of 
where to start. 
 

·  Try looking into the configurability of the panels and the toolbars. You 
can show or hide all the panels and the toolbars and move them to any 
position you want.  Try right-clicking on a tool bar and the customize 
menu will appear.  To enable bar configuration, turn off the “Locked” 
option. 

 
·  Try setting the keyboard shortcuts for tool buttons using the keyboard 

option on the customize menu.   
 
 
 
This concludes the introduction to the User Interface.  Next, the concept of 
projects will be explored. 



 
 

Project Based Working 
 
The way Simmetry3d handles saving and loading your work works in the 
same way as a word processor works.  In a word processor you save a 
document that contains all the words and images that you entered.   
 
Simmetry 3d also works in the same manner.  When you build a scene in 
Simmetry 3d you can save all the information you’ve created to a file.  The 
saved file is referred to as a “project”. 
 
Once the project is saved you may reload this project at anytime and 
Simmetry3d will restore the three dimensional scene as you saved it. 
 
The current project filename is displayed in the caption at the very top of the 
window.   
 
Please note that you may only have one project loaded in Simmetry 3d at a 
time.  Opening a new project will cause the existing project to be closed. 
 

Loading a Project  
 
To load a project, you need to select the File|Open option from the menu 
system. 
 

EXERCISE 
 

·  Open the File menu 
·  Select “Open…” Option 
 

 
 

This gives you a standard Windows Open dialog. 
 

·  Choose “Project1.s3d” 
·  Press Open 

 
This will have loaded the project into Simmetry3d. 
 
Now you will see that the 3d scene will have altered to display a terrain saved 
in the Project1 file. 
 

Creating a new Project  
 



To create a brand new project with a blank terrain, you need to select the 
File|New menu option.  This will present you with a dialog to specify various 
values for the terrain, such as the width and breadth in metres of the terrain. 
 

 
 
 

EXERCISE 
 

·  Open the File menu and select the New option 
·  Step through the pages in the wizard by pressing the “Next” button. 

Then press the “Finish” button at the end. 
 
The three dimensional view will now show a blank terrain once again. 
 

Saving a Project 
 
To save the file you need to select the File|Save option from the menu. This 
will open a window that will ask for a filename and when you press the “save” 
button the project will be written out to disk. 
 
You can tell if your project needs saving by looking at the status bar. 
 

 
 
If the disk icon is visible you have altered the current project and you will lose 
your changes if you do not save your project, but Simmetry3d will ask you if 



you wish to save it before it closes or before you load a new project so that 
you will not lose your changes. 
 

The Project Tree 
 
This panel gives a hierarchical display of all the elements that comprise a 
Simmetry3d project.  It gives you direct access to all the different parts of a 
project quickly. 
 

 
 
The indentation of each item shows how it relates to the other items. An item 
is said to “contain” all the items that are indented below it. There are lines to 
show how the items are connected.  This hierarchy is used to provide 
structure to the project and give easy access to functionality through these 
groupings. 
 
 
As you progress through the tutorials the meaning of each item in the Project 
Tree will become apparent.  For now we will look only at the top item, 
“Project”. This is the least indented item and therefore contains all the other 
items.   
 
The Project Tree is not just an overview of what is contained in the project, 
but also provides access to functionality.  By right-clicking the mouse on a 
particular item a menu will appear with items specific to that type of item. 
 

EXERCISE 
 

·  Move the mouse cursor over the “Project” item in the Project Tree. 
·  Press the right mouse button on the “Project” item. 
·  Select “Properties” 



 
This shows a dialog that holds information specific to the project. 
 

 
 
 

·  The categories are shown on the left hand side; clicking each of these 
will show the associated settings on the right hand side. 

·  Press the “Cancel” button 
·  Open the File menu  
·  Select the “Properties” menu item 

 
This brings up the same dialog as the Project Tree menu did. 
 

·  Press the “Cancel” button 
 
This shows there is often more than one way to access the same functionality 
in Simmetry3d to provide flexible ways of working. 
 
 



Viewing in three dimensions and Simmetry 3d Viewports 
 
So far, we have only looked at the three dimensional view from one fixed point 
of view.  This section explains how we can have more than one view on the 
scene at once and the different styles of view available.  Each individual view 
can also be referred to as a Viewport. 
 
In this section, we shall be making use of the camera tool bar. 
 

 

Multiple Views 
 
Simmetry3d may allow the user to have up to four different views on the same 
scene. 
 

 
 
Notice that when there is more than one view visible, one of the views has a 
red border around.  This is the Active Viewport.  This is the view that will 
receive the input from the user.  To change the active Viewport, left click on 
the Viewport you wish to make active and the red border will move to that 
view. 
 

EXERCISE  
 

·  Load the project “Project1.s3d” 
·  Locate the camera tool bar  



·  Press the Horizontal Twin Camera View button and you will get a 
split view of the scene 

·  Try each camera view button on the camera tool bar 
·  Set up four views  
·  Select the top right view as the active Viewport 
·  Select the bottom left view as the active Viewport 

 

View Type 
 
Each Viewport also has a setting that says what type of view it is.  The options 
are: 
 

 
1. Isometric  
2. Plan 
3. Front Elevation 
4. End Elevation 
5. Left Side 
6. Right Side 
 

All of these views, apart from Isometric, are fixed to view from a certain point 
and are orthogonal by default. 
 
On the camera toolbar there is a drop down list that contains these options. 
 

 
 
The option displays which view type the active Viewport is currently set to.  
Select the view style you want from the row of buttons to change the view 
style of the active Viewport. 
 
 



EXERCISE  
 

·  Press the  Vertical Twin Camera View button and you will get a split 
view of the scene 

·  Set the View Style of the active viewport to Top 
·  Cycle through all the view style options 

 
 

 

Simmetry 3d Tools 
 
In this section you will be introduced to the structure of Simmetry3d Tools.  A 
tool is really an interactive piece of functionality that may allow users to set 
some parameters that will alter the way the tool works. 
 
Each tool will perform a different objective, but they will display their 
information to the user in a consistent way.  They are started by clicking on 
the appropriate menu item or tool button. 
 
When you start a tool it will place any relevant options on the Tool Options 
Bar. 
 

  
 
You may see which tool is running in the status bar.  This is referred to as the 
current tool.  
 

 
 
The name of the current tool is displayed to the right of project saved disk 
icon.   Here in this example a tool called “Fixed Rotate” is running. 
 
By starting another tool you automatically close the current tool, so you do not 
have to worry about specifically closing a tool first. 
  



When you click the right mouse button on the three dimensional view a menu 
will popup.  This is referred to as the tool popup menu. 
 

    
 

This menu will contain several different options.  Top most of the list is always 
an option to cancel the current tool. Then there is a history of tools that you 
may start again.  At the bottom there may also be a series of options relevant 
to the tool, but not every tool has this feature. 
 
 

EXERCISE  
 

·  Open Terrain menu 
·  Select “Build” option to start the “Build tool” 
·  Notice how the tool options bar is now full of parameters to set.  Don’t 

worry about what they mean at this point. 
·  Check the status bar to see the name of the tool running 
 
·  Open the Terrain menu  
·  Select the “Water Height” option to start the “Water Height Tool” 
·  Notice the different set of options of the tool options bar 
·  Right-Click on the three dimensional view to get the tool popup menu. 

 
 
This section is designed only to show you the similar user interface tools use 
to present their information to you. You will learn more about the specifics of 
the tools in later tutorials. 
 
 
 
 
 
 
 


